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Features and Functions available in  
Te Kete Kōrero a Te Takutai Moana Information Hub (Kōrero Takutai) 
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1. Zoom In / Topa Mai. 

2. Zoom Out / Topa Atu. 

3. Default Extent / Tirohanga Taunoa. 

4. My Location / Taku Tauwāhi. 

5. Layer List / Rārangi Apa. 

6. Print Current View / Tuhi Mātuha. 

7. Select / Kōwhiri. 

8. Measure / Mēhua. 

9. Query / Ui. 

10. Draw / Tuhi. 

11. Basemap Gallery / Mapi Matua. 

12. Filter / Tātahi. 

13. About—Information / Mō Te Ata. 

14. Add Data / Tāpiri Rauranga. 

15. Legend / Whakamōhio Mapi. 

16. Full Screen / Mata Rorohiko Nui.  

17. Show Map Overview / Tiro Whanui Mapi. 

18. Attribute Table / Ripanga Rauranga.  



1. Zoom In / Topa Mai.

Use the ‘Zoom Out’ button to zoom out of the map. 

3. Default Extent / Tirohanga Taunoa.

The ‘Default Extent’ button returns the map to the original zoom level, which is the level when first opened. 

4. My Location / Taku Tauwāhi.

The ‘My Location’ button zooms the map to your current location. 

Click on the ‘My Location’ button. 

• You may need to enable the relevant location services to allow your location to be displayed on the map. Click ‘Allow’ if a pop-up appears asking to do

this.

• Click on the ‘My Location’ button again to remove your location from the map.

2. Zoom Out / Topa Atu.

Use the ‘Zoom In’ button to zoom into the map. 



5. Layer List / Rārangi Apa. 

The ‘Layer List’ button allows you to customise the data layers overlaid on your basemap. 

Each added layer is listed in the layer list window. Some layers contain sublayers and subtypes. 

The order in which layers are listed in the layer list window corresponds to the order in which the layers are overlaid on the map. 

If not open by default, click on the Layer List button at the 

bottom of the screen. 

The layer list has several useful capabilities. 

• Search. 

• Click on the search button at the top right corner 

of the layer list to search for layers within the layer 

list. 

• Note: Layers become unavailable when zoomed 

out of their visibility range. 

• Control all layers. 

• Click on the ‘Control all layers’ button in the upper 

right of the layer list to make changes to all layers 

in the list. Options are: 

• Turning all layers on and off. 

• Collapsing and expanding all layers. 

• Turn added layers on and off. 

• Click on the check box next to the layer name to 

turn the layer on and again to turn it off. 

 



• Zoom to the selected layer. 

• Click on the three dots next to the layer name to open the layer menu and select ‘Zoom to’. 

• Set the layer transparency. 

• Click on the three dots next to the layer name to open the layer menu and select ‘Transparency’. 

• Set the layer transparency using the slide bar provided. 

• Set the scale visibility for the layer. 

• Click on the three dots next to the layer name to open the layer menu and select ‘Set visibility range’. 

• Set the visibility range using the slide bar provided. 

• Disable and enable layer pop-ups. 

• Click on the three dots next to the layer name to open the layer menu and select ‘Disable/Enable pop-up’. 

• If a layer does not have a pop-up configured in the map, clicking Enable Pop-up shows all field values for the feature layer.  

• Change the position of the layer in the map. 

• Click on the three dots next to the layer name to open the layer menu and select ‘Move up’ or ‘Move down’. 

• Open the attribute table for the layer. 

• Click on the three dots next to the layer name to open the layer menu and select ‘View in attribute table’. 

• Display the layer details. 

• Click on the three dots next to the layer name to open the layer menu and select ‘Show item details’. 



6. Print Current View / Tuhi Mātuha. 

The ‘Print Current View’ button allows you to export your map (as it appears on your screen at that time) in various formats. 

Caution: A map overloaded with data layers may not print properly. 

Click on the ‘Print Current View’ button to open the print window. 

• Ensure the current view on your screen is the view you want to export. 

• Set your page layout from the ‘Layout’ drop-down menu. 

• Set your export format from the ‘Format’ drop-down menu. 

• Enter a title for your map in the ‘Map title’ box. This option is provided for 

all formats except ‘Map only’. 

• Click on the ‘Print’ button. Your map will be exported in your chosen for-

mat and will appear listed in the print window. Click on the listing to open 

your map. 

• Repeat the process to create different maps. All printed maps will remain 

listed in the print window unless you click on the ‘Clear prints’ button. 

• Click on the ‘Clear prints’ button to delete the map list. 

Click on the ‘Advanced’ button to open a menu with advanced print options. 

• Map scale/extent: 

• If ‘Preserve map scale’ is selected the map will maintain its scale and adjust its extent around the existing centre point. 

• If ‘Preserve map extent’ is selected, the map will maintain its extent and adjust its scale. 

• You can stipulate the map scale by clicking on the ‘Force scale’ option and entering your desired scale. 

• Click on the ‘current’ option to enter the scale currently used on screen. 

 



Layout metadata: 

• If any format other than ‘Map Only’ is selected, you can set the details you want to ap-

pear on your map. 

• The ‘Author’ and ‘Copyright’ fields are filled by default but can be changed if you wish. 

• Check the ‘Include legend’ box if you want the legend to appear on your map. 

• Set the scale unit using the drop-down list provided. 

‘Map Only’ size: 

• If the ‘Map Only’ format is selected, this function allows you to stipulate width and 

height in pixels. 

Print quality: 

• Allows you to stipulate the resolution of your map in DPI (dots per inch) by typing into 

the text box provided. 

 

 

 



7. Select/Kōwhiri. 

The ‘Select’ button allows you to isolate information within a specific area. You can then perform actions on selected features. 

Click on the ‘Select’ button to open the select window. 

• The window will display a list of selectable layers.  

• You can specify the layers you want to select from by turning 

these layers on or off using the check boxes to the left of the layer 

name.  

• You can make all layers selectable or unselectable, or toggle all 

layers, by clicking on the ’All Layers’ button in the top right of the 

list and choosing your option from the drop-down menu.  

• Draw your selection shape on the map to select the desired features. 

• Click on the ‘Select’ button at the top of the select window.  

• Choose your selection shape. The options are shown in the image 

on the right. 

• The following functions are available if you select by rectangle: 

• Click and drag your mouse pointer over the feature to select 

it. 

• Select multiple features by holding the ‘Shift’ key while click-

ing and dragging. 

• Remove features from your selection by holding the ‘Ctrl’ 

key while clicking and dragging. 

 



• A number will appear to the right of the selected layers to show you how many 

features have been selected in each layer. 

• Click on the three dots to the right of the selected layers to open the ‘Selection 

actions’ menu. 

• The action options are shown in the image on the right. 

• Click on the actions to carry them out. 

• Click on the selected layer to see a list of all selected features. 

• Click on the feature to bring up the pop-up with further detail about the 

feature. 

• Click on the back arrow button in the top left to go back to the selectable 

layer list. 

• Click on the ‘Clear’ button to clear all selections. 



8. Measure / Mēhua. 

The ‘Measure’ button allows you to measure the area of a polygon, the distance of a line, or find the coordinates of a point. 

Click on the ‘Measure’ button to open the measure window. 

To measure the area of a polygon: 

• Click on the ‘Area’ button (left). 

• Select the desired measurement unit from the drop-down box. 

• Draw a polygon on the map around the area you want measured. This 

capability will be automatically enabled. You do not need to open the ‘Draw’ 

tool. 

• The measure tool will calculate the area of the polygon and the measurement 

will be displayed in the measure window. 

 

To measure the distance of a line: 

• Click on the ‘Distance’ button (centre). 

• Select the desired measurement unit from the drop-down box. 

• Draw a line on the map between the points you want to measure. This 

capability will be automatically enabled. You do not need to open the ‘Draw’ 

tool. 

• The measure tool will calculate the distance between the points and the 

measurement will be displayed in the measure window. 

 

 



To find out the coordinates of a point: 

• Click on the ‘Location’ button (right). 

• Select the desired coordinate format from the drop-down box. 

• Drop a point on the map by clicking on the place for which you want 

coordinates. This capability will be automatically enabled. You do not need to 

open the ‘Draw’ tool. 

• The ‘Measure’ tool will calculate the coordinates of the point and these will be 

displayed in the measure window. The coordinates of the location of your 

mouse arrow will also be displayed. 



9. Query / Ui. 

The ‘Query’ button allows you to narrow down the data displayed in the application layers. By querying the layers you can display specific applications 

matching the query criteria. 

Click on ‘Query’ button to open the query window. 

The ‘Tasks’ tab displays 13 ways of querying the application layers. These are: 

1. Find High Court Application by CIV Number. 

2. Find Crown Engagement Application by MAC Number. 

3. Find High Court Application by Applicant Group. 

4. Find Crown Engagement Application by Applicant Group. 

5. Find High Court Application by Applicant. 

6. Find High Court Applications by Region. 

7. Find Crown Engagement Applications by Region. 

8. Find High Court/Crown Engagement Applications by Region. 

9. Find Overlapping High Court Applications for Selected Application Area. 

10. Find Overlapping High Court Applications Using Draw Tool. 

11. Find Overlapping Crown Engagement Applications for Selected Application Area. 

12. Find Overlapping Crown Engagement Applications Using Draw Tool. 

13. Find Overlapping High Court/Crown Engagement Applications by Selected Application Area. 

14. Find Overlapping High Court/Crown Engagement Applications Using Draw Tool. 

 

 



To find an application by CIV/MAC number, applicant/applicant group, or 

region: 

• Click on the query you want to execute. The query criteria will appear 

in the ‘Tasks’ tab. 

• Select the number, name or region from the drop down list. 

• If you wish to, specify the result layer name in the text box below.  

• Click the ’Apply’ button.  

• The query will execute and the map will zoom to the application area

(s) relating the query. 

• The resulting application area(s) will appear as a layer in the ‘Layer 

List’ window labelled as the name you specified or as the default 

‘Query result’. 

• The details of the resulting application area(s) will be displayed in the 

‘Results’ tab in the query window. These details will also be displayed 

in a pop-up if you click on the application area(s). 

• The ‘Results’ tab provides ways to arrange the information resulting 

from your query: 

• Displayed features tells you how many results are shown in the 

window out of all results returned. Click on the small down ar-

row to load more results for display. 

• Result feature details can be expanded and collapsed. 

• Click on the ‘Expand/Collapse all’ buttons to expand or 

collapse all feature details at once. 

• Click on the up or down arrow next to each result feature 

to expand or collapse details by individual feature. 

The application area shown in this image is entirely fictional and was created for the purpose of training. 



• Click on the ‘Feature actions’ button (the three dots in the top right corner of 

the ‘Results’ tab) to perform the following actions: 

• To zoom or pan to a feature. 

• Make a feature flash briefly. 

• Display the feature’s details by pop-up. 

• Display the feature’s details in the attribute table. 

• Change the feature’s symbology (colour, transparency, outline). 

• To remove the query result, click on the ‘Feature actions’ button and select 

‘Remove this result’ from the menu. 

• To execute another query, click on the ‘Tasks’ tab, then click on the back arrow in 

the top left corner. This will bring you back to the list of possible queries. 

 

To find the overlapping applications of a specific application area: 

There are TWO ways of finding the overlapping applications of an application area—by 

selecting the application area or by using the draw tool 

Find overlapping applications by selecting an application area: 

• Select the application area for which you want to identify overlapping applica-

tions by: 

a. Using the ‘Select’ tool (see ‘7. Select’); 

b. Using the ‘Attribute Table’ (see ‘18. Attribute Table’); or 

c. Using the ‘Query’ tool as described in the previous section. 

• If the application area was selected using the ‘Select’ tool or ‘Attribute 

Table’: 

• Once the application area is selected, click on the ‘Query’ button  

The application area shown in this image is entirely 
fictional and was created for the purpose of training. 



to open the query window. 

• Select the overlap query you wish to execute. The options are: 

• Find Overlapping High Court Applications for Selected Application Area. 

• Find Overlapping Crown Engagement Applications for Selected Application 

Area. 

• Find Overlapping High Court/Crown Engagement Applications by Selected 

Application Area. 

• This will bring you to the ‘Spatial filters’ window. 

• In the ‘Related layer’ drop-down box, select the layer in which you selected your 

initial application area (i.e. one of the two application area layers). 

• Select the checkbox for ‘Use selected features’. 

• Click on ‘Apply’. The query will execute and the results will be displayed in the 

results panel. 

• If the application area was selected using the ‘Query’ tool: 

• Once the application area is selected, click on the ‘Tasks’ tab (do not remove the 

result from the ‘Results’ tab). 

• Click on the back arrow in the top left of the ‘Tasks’ tab. This will bring you back 

to the list of possible queries.  

• Select the overlap query you wish to execute. The options are the same as those 

listed above. 

• This will bring you to the ‘Spatial filters’ window. 

• In the ‘Related layer’ drop-down box, select the layer in which you selected your 

initial application area (i.e. the ‘Query result’ layer). 

• Click on ‘Apply’. The query will execute and the results will be displayed in the results 

panel. 



Find overlapping applications by using the draw tool: 

• Add the application area layer you want to query to the layer list. 

• Click on the ‘Query’ button to open the query window. 

• Click on the overlap query you wish to execute. The options are: 

• Find Overlapping High Court Applications Using Draw Tool. 

• Find Overlapping Crown Engagement Applications Using Draw Tool. 

• Find Overlapping High Court/Crown Engagement Applications Using 

Draw Tool. 

• This will bring you to the ‘Spatial filters’ window. 

• Click on one of the draw tools supplied and mark the application area for 

which you want to see overlapping applications. 

• Click on ‘Apply’. The query will execute and the results will be displayed in 

the results panel. 



10. Draw / Tuhi. 

The ‘Draw’ button allows you to draw simple graphics and text on the map.  

You can also use it to add measurements, such as line length and polygon area, to a feature as text.  

Click on the ‘Draw’ button to open the draw window. 

Select a draw mode. The options are shown here on the right. 

The four most useful draw modes are: 

• Point 

• Click on the ‘Point’ button. 

• Select the point type from the drop down menu. Different sym-

bols are available within each category. 

• Set the size, colour, transparency, outline colour, and outline 

width. For picture symbols only the size field is available.  

• If you wish to display the coordinates next to the point on your 

map, activate the ’Show location measurement’ slide bar. 

• Set the unit, font size and font colour of the measurement 

text. 

• Place the point on the map by clicking on the map in the desired 

location.  

• You can create as many points as you wish. 

• To undo and redo your point, or to clear your drawing entirely, 

use the buttons at the bottom of the Draw tool window. 

• Note: You can use points to create a polygon. 

 

Point Line Polyline 

Freehand 

Polyline 
Arrow Triangle 

Rectangle Circle Ellipse Polygon Freehand 

Polygon 

Text 



• Line 

• Click on the ‘Line’ button. 

• Select a line type from the window. 

• Set the colour, style, transparency and width. 

• If you wish to display the length measurement next to the line on your 

map, activate the ’Show length measurement’ slide bar. 

• Set the unit, font size and font colour of the measurement text. 

• To create a line, click on the map where you want your line to start, hold 

and drag the line to the desired endpoint, and release. 

• To undo and redo your line, or to clear your drawing entirely, use the 

buttons at the bottom of the Draw tool window. 

• Polygon 

• Click on the ‘Polygon’ button. 

• Select a polygon style from the window. 

• Set the fill colour, outline colour, transparency, and outline width. 

• If you wish to display the area and perimeter measurement next to the 

polygon on your map, activate the ’Show area measurement’ and ‘Show 

perimeter measurement’ slide bars. 

• Set the unit, font size and font colour of the measurement text. 

• To create a polygon, click and release on the map for each of the verices 

(the ‘corners’) of the desired polygon. Double click to complete. 

• To undo and redo your line, or to clear your drawing entirely, use the 

buttons at the bottom of the Draw tool window. 

 



• Text 

• Click on the ‘Text’ button. 

• Set the font size and colour. 

• Type your desired text in the ‘Text’ box. A preview of your text 

will be displayed. 

• Add the text to your map by clicking in the desired location. 

• Press Ctrl and click to snap to a particular point. 

 

How to create a polygon using points. 

This function is especially useful for creating application areas. 

• Click on the Point button in the Draw tool window. 

• Set the details of your points 

• Create points at all the vertices (the ‘corners’) of the desired polygon. 

• Click on the Polygon button in the Draw tool window. 

• Set the details of your polygon. 

• Click on each of the points to create your polygon. Double click on the 

last to complete the polygon. 

• Press Ctrl and click to snap to the point. 



11. Basemap Gallery / Mapi Matua. 

The ‘Basemap Gallery’ button allows you to select different basemaps as the background for your map.  

All basemaps added to the gallery must have the same spatial reference. 

 

Click on the ‘Basemap Gallery’ button and select the basemap you want to use. 



12. Filter / Tātahi. 

The ‘Filter’ button allows you to decide what features are visible within a data layer using SQL language. Only the features that meet the criteria defined by 

the user will be visible on the map. 

Other buttons will, if applicable, respond to changes made by using the Filter button. 

Click on the ‘Filter’ button to open the filter window.. 

• Click on the three dots at the bottom right of the Filter window. 

• Click on the ‘Create a custom filter’ button. 

 

• Select the layer you want to filter from the drop-down list in 

the custom filter window, e.g. ‘Māori Land Court Spatial Data 

May 2017’. 

• Click on the ‘Add expression’ or ‘Add Set’ button to define the 

filter condition in the custom filter dialogue box. 



• Select the field you wish to filter by, e.g. Block Name. 

• Select the operator from the drop-down list, e.g. ‘is’. 

• There are 10 operators that can be used to filter the layer 

(see image below). 

• Select the value from the predefined list, e.g. ‘Unique’. 

• There are four values that can be used to filter the layer (see 

image below). 

• This will enable a drop-down list from which you can select 

your filter criteria, e.g. ‘Ahiateatua’. 

• Alternatively, simply type in your filter criteria, e.g. ‘Ahiateatua. 

• All features matching your filter criteria will become visible on the 

map. 



13. About - Information / Mō Te Ata. 

The ‘About - Information’ button displays the content of each button in Kōrero Takutai and provides instructions for navigating pop-up windows. 



14. Add Data / Tāpiri Rauranga. 

The ‘Add Data’ button enables you to add layers information to the map. These layers can be from Kōrero Takutai, your own data, or something you have 

found on the internet. You can temporarily add and and remove layers to and from the map but you cannot save layers to the map.  

Click on the ‘Add Data’ button to open the data window. 
 
There are 3 tabs in the data window: Search, URL, and File. 

Search 

• Use the search tool to find data layers matching your search term. 

• The selection box (the down arrow to the left of the search tool) allows you to select the 

source of information). 

• Find the layer you want to add to the map and click the ‘ADD’ button for that layer. The 

layer will appear on the map and in the ‘Layer List’ window on the left. 

• Click on the ‘Details’ button for more information about the data layer. 

• Once the layer is added, the ’ADD’ button will change to a ‘REMOVE’ button. Click on the 

‘REMOVE’ button to remove the layer from the map and the layer list. 

URL 

• The ‘Type’ selection box allows you to select the type of URL you wish to 

import. The following types are supported in Kōrero Takutai: 

• ArcGIS Server web service 

• WFS OGC web service 

• WMS OGC web service 

• KML layer 

• GeoRSS feed 

• CSV file 



• Choose a type and enter the URL.  

• Click the ‘Add’ button to add the URL data to the map. The data layer will appear on the map and in the ‘Layer List’ pane on the left. 

Note: If the URL layer that has a spatial reference different from that of your basemap, especially the tile layers, the added layer might not be visible. 

File 

• The ‘File’ tab allows you to upload your own data to the Kōrero Takutai map. 

The following formats are supported in Kōrero Takutai: 

• CSV 

• GPX 

• GeoJSON 

• KML 

• Shapefile 

• Click on the ‘Browse’ button to open a window to add your files. 

• The ‘Layers’ button allows you to view the data layers you have uploaded. 

• To remove added layers, click on the ‘Layers’ button to open the layers 

window and click on the ‘Remove Layer’ button next to the layer. 

• Click ‘Back’ in the lower right corner to return to the main panel. 



15. Legend / Whakamōhio Mapi. 

The ‘Legend’ button opens the map legend to show you the layers currently displayed on the map. This is especially helpful if there are many layers dis-
played at once. The legend is open by default when you open Kōrero Takutai. 
 
Layers have to be ‘on’ in the layer list in order to appear in the legend. When there are no active layers on the map the legend will be empty. 
 
The order in which layers are listed in the legend corresponds with the order they are laid on the map. 



16. Full Screen / Mata Rorohiko Nui.  

The ‘Full Screen’ button displays the map in full-screen mode, hiding the panel of text on the left hand side, and the tabs along the top.  

 

Click on the ‘Full Screen’ button to open full screen mode. 

Click again or press Esc to leave full screen mode and return to the default view. 



17. Show Map Overview/Tiro Whanui Mapi. 

The ‘Show Map Overview’ button displays a small map in the top right corner of the screen. This ‘map overview’ shows the current map extent and is useful 

in showing your location when zoomed into the map at a small scale. 

 

Click on the ‘Show Map Overview’ button to display the map overview. 

Click again to hide the map overview. 



18. Attribute Table / Ripanga Rauranga.  

The ‘Attribute Table’ button opens a table showing the qualitative information (attributes) of the active layers displayed on the screen. This is where you can 

see the information displayed in the pop-up query panels but for more the one feature at once. 

 

The attribute table displays at the bottom of the screen and can be opened, resized and closed. 

 

When more than one layer’s attributes are displayed, multiple tabs will be automatically generated in the table allowing you to toggle between the 

attributes for each layer.  

There are two ways of turning the attribute table on and off. 

• Click the ‘Attribute Table’ button in the bottom right of the screen. 

OR 

• Open the ‘Layer List’ and click on ‘View in Attribute Table’ beside the 

layer you want to open. 

 

 
There are different functions within the attribute table.  

If viewing more than one layer in the attribute table, make sure you have selected the layer 

you want to work with. The layer tabs are at the top left of the attribute table. 

• Select a record. 

• Click on a record in the table to select it and highlight the corresponding 

feature in the map. The feature will be highlighted in the same colour as the 

selected record in the attribute table. 

• Hold the Shift or Ctrl key to select multiple records. 



• Show selected records. 

• Displays selected features. 

• Click the ‘Options’ button and select ‘Show selected records’. 

• Show related records. 

• Displays related records if a selected record has a related tabel. 

• Click on the ‘Options’ button and select ‘Show related records’. 

• Filter by map extent. 

• Displays attributes for features within the current map extent. 

• Click on the ‘Options’ button and select ‘Filter by map extent’. 

• Show/Hide columns. 

• Allows you to select what is visible in the attribute table. 

• Click on the ‘Options’ button, then the ‘Show/Hide columns 

button. 

• Check or uncheck the fields to selct what is visible in the attribute 

table. 

• Zoom to selected feature. 

• Click the ‘Zoom to’ button to reset the map extent and center 

around selected features. 

• Double-clicking a field in the selected record also zooms to the 

feature on the map.  

• Clear selections. 

• Click the ‘Clear Selection’ button to clear all selections. 

• Refresh. 

• Click the ‘Refresh’ button to refresh the table. 

• Copy the field value. 

• Double click the field value to highlight it, and right-click it to copy 

the value. 

• Sort a field. 

• Click a field heading to sort the records by this field. 




